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Introduction

In this section:

• product features

• system requirements

• guide conventions

• technical support contact information

Product Features

Cirond pocketWiNc™ automatically detects Wi-Fi® networks and lets you quickly determine 
whether you can access the internet. Once you are connected, you can download e-mail or 
browse the web with just a tap the screen. Cirond pocketWiNc™ also allows you to store 
personalized profiles for individual Wi-Fi® locations, a capability not commonly found on 
Pocket PC devices.

As well as making it easy to get connected, Cirond pocketWiNc™ provides client-side support for 
all functions of Cirond WiNc Manager™. For more information on other Cirond products, visit 
www.cirond.com, or send an e-mail to info@cirond.com.

Cirond pocketWiNc™ also helps network administrators inspect, manage and tune Wi-Fi® 
networks for optimum performance.

Cirond pocketWiNc™ is based on Cirond's WiNc™ technology and is available for Pocket PC 2002 
and Windows® CE .NET. Cirond pocketWiNc™ is compatible with the IEEE 802.11b standard.



 Cirond pocketWiNc™ User Guide

Introduction — 2 —

Cirond pocketWiNc™ provides:

• automatic Wi-Fi® network detection of all available networks including SSID, channel, 
and WEP state

• internet availability detection for each identified Wi-Fi® network

• user network profiles that enable users to automatically connect to preferred Wi-Fi® 
networks based on a user-defined priority sequence including automatic WEP key support

• universal Wi-Fi® card support for most major built-in and CompactFlash® Wi-Fi® cards

• quick connection to web browser and e-mail applications

• support for Cirond’s AutoKey™ WEP key distribution system

• support for portrait and landscape screen modes

How to Use This Guide

The following instructions describe specific user actions:

• tap — perform an operation by touching the stylus to an object in the window (i.e., a 
window button, menu or icon); also used to select an item

• tap and hold — press the stylus against the screen and hold it there; after a moment 
the context menu appears

• select — choose an option from a menu or list of objects (i.e., a file, device or menu 
option), tap the option; there will be a visual change in the display, depending on the 
action you've taken

• drag and drop — tap the item to be moved, then tap and hold the item, drag the item 
to its new location, and lift the stylus
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This guide uses the following formatting conventions to describe screen objects:

• Fields and objects appear in dark blue, bold text.
Example: Tap the Close button.

• Words or character strings that you are instructed to type, and monitored system 
information displayed within the GUI, appear in italics.
Example: Type password in the Password field.

• Hyperlinks, including cross-references within this guide, appear in blue text
Example: For more information, visit us at www.cirond.com.

• Glossary terms appear in light blue, bold text (first occurrence only).
Example: The MAC address is used as a BSSID (Basic Service Set Identifier).

Technical Support

Before contacting Cirond Technical Support, refer to the Customer Service page at 
www.cirond.com.

If you are still unable to resolve the problem, send a detailed message to support@cirond.com. 

In your e-mail, be sure to include:

• the version number of Cirond pocketWiNc™

• the name and version number of your operating system

• the name, manufacturer and version number of your wireless adapter

Tip: This guide uses basic networking terminology. For more information 
about these terms, refer to the appended Glossary.
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• a detailed description of the problem, including any steps necessary to reproduce it

Cirond’s Software License Agreement

You, as Licensee of the Software covered by this agreement, agree to the following terms and 
conditions with the Licensee (Cirond Technologies Inc.) concerning this Software:

1. This is an agreement between Licensor and Licensee, who is being licensed to use the named 
Software.

2. Licensee acknowledges that this is only a limited, nonexclusive license. Licensor is and 
remains the owner of all titles, rights, and interests in the Software.

3. This License permits Licensee to install the Software on more than one computer system, as 
long as the Software will not be used on more than one computer system simultaneously. 
Licensee will not make copies of the Software or allow copies of the Software to be made by 
others, unless authorized by this License Agreement. Licensee may make copies of the Software 
for backup purposes only.

4. This Software is subject to a limited warranty. Licensor warrants to Licensee that the physical 
medium on which this Software is distributed is free from defects in materials and workmanship 
under normal use. This limited warranty lasts for a period of 30 days after delivery. To the extent 
permitted by law, THE ABOVE-STATED LIMITED WARRANTY REPLACES ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, AND LICENSOR DISCLAIMS ALL IMPLIED WARRANTIES 
INCLUDING ANY IMPLIED WARRANTY OF TITLE, MERCHANTABILITY, NONINFRINGEMENT, OR 
OF FITNESS FOR A PARTICULAR PURPOSE. No agent of Licensor is authorized to make any other 
warranties or to modify this limited warranty. Any action for breach of this limited warranty must 
be commenced within one year of the expiration of the warranty. Because some jurisdictions do 
not allow any limit on the length of an implied warranty, the above limitation may not apply to 
this Licensee. If the law does not allow disclaimer of implied warranties, then any implied 
warranty is limited to 30 days after delivery of the Software to Licensee.

5. In case of a breach of the Limited Warranty, Licensee's exclusive remedy is as follows: 
Licensee will return all copies of the Software to Licensor, at Licensee's cost, along with proof of 
purchase. (Licensee can obtain a step-by-step explanation of this procedure, including a return 
authorization code, by contacting Licensor by e-mail at support@cirond.com). At Licensor's 
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option, Licensor will either send Licensee a replacement copy of the Software, at Licensor's 
expense, or issue a full refund.

6. Notwithstanding the foregoing, LICENSOR IS NOT LIABLE TO LICENSEE FOR ANY DAMAGES, 
INCLUDING COMPENSATORY, SPECIAL, INCIDENTAL, EXEMPLARY, PUNITIVE, OR 
CONSEQUENTIAL DAMAGES, CONNECTED WITH OR RESULTING FROM THIS LICENSE 
AGREEMENT OR LICENSEE'S USE OF THIS SOFTWARE.

7. Licensee agrees to defend and indemnify Licensor and hold Licensor harmless from all claims, 
losses, damages, complaints, or expenses connected with or resulting from Licensee's business 
operations.

8. Licensor has the right to terminate this License Agreement and Licensee's right to use this 
Software upon any material breach by Licensee.

9. Licensee agrees to return to Licensor or to destroy all copies of the Software upon termination 
of the License.

10. This License Agreement is the entire and exclusive agreement between Licensor and 
Licensee regarding this Software. This License Agreement replaces and supersedes all prior 
negotiations, dealings, and agreements between Licensor and Licensee regarding this Software.

11. This License Agreement is governed by the law of the State of Colorado.

12. This License Agreement is valid without Licensor's signature. It becomes effective upon the 
earlier of Licensee's signature or Licensee's use of the Software.
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Using Cirond pocketWiNc™

In this section:

• how to install Cirond pocketWiNc™

• how to use Cirond pocketWiNc™ menus

• how to use Cirond pocketWiNc™ with available 
networks

Important: This section describes how to use Cirond pocketWiNc™ within the Pocket PC 
environment. Cirond pocketWiNc™ for Windows® CE .NET offers the same 
functionality, but with a slightly different graphical user interface.

Installing Cirond pocketWiNc™

The following installation instructions are written with the assumption that you are 
familiar with using Microsoft® ActiveSync® and that it is installed in your desktop 
computer.

1. Connect your PDA to your desktop computer using either the cradle or cable that came 
with your PDA.

2. Synchronize your PDA to your desktop computer via Microsoft® ActiveSync®.

3. At your desktop computer, locate and open the setup.exe file. The Welcome window 
opens.
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4. Tap the Next button. The License Agreement window opens.

5. To accept the agreement and continue with the installation, select the I accept the 
terms in the license agreement radio button and tap the Next button. The Customer 
Information window opens.

6. Type your user name and organization in the fields provided. 

To install the application for all users, select the Anyone who uses this computer 
(all users) radio button. 

To install the application for yourself only, select the Only for me (User Name) 
radio button.

To continue, tap the Next button. The Setup Type window opens.

7. To install Cirond pocketWiNc™ without modifying the setup, select the Complete radio 
button. Tap the Next button and go to Step 9.

To install Cirond pocketWiNc™ using a custom setup, select the Custom radio button. 
Tap the Next button. The Custom Setup window opens.

8. The Custom Setup window includes several user-dependent options. Make changes as 
required and tap the Next button. The Ready to Install the Program window opens.

9. To begin installation, tap the Install button. The Installing Application window opens. To 
install to the default application directory, tap the Yes button. The installation may take a 
few moments to complete.

10. Once the installation is complete, a message will direct you to the mobile device. To close 
the window, tap the OK button.
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11. At the mobile device, the Cirond pocketWiNc™ Setup window opens. To soft-reset the 
device, tap the Yes button. To finish the installation and close the window without soft-
resetting, tap the No button.

Cirond pocketWiNc™ Program Window

The Cirond pocketWiNc™ program window includes the menu bar, screen context menus, and 
shortcut icons for e-mail and internet access. Cirond pocketWiNc™ automatically searches for 
and displays a list of active networks.

Cirond pocketWiNc™ also displays a list of preferred networks. By default, the Preferred 
Networks list is displayed at the bottom of the program window. See Figure 1.

Tip: To run Cirond pocketWiNc™ immediately, choose Yes. Otherwise, 
Cirond pocketWiNc™ will not run until you soft-reset the device 
manually.
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Figure 1: Program window — Show at bottom (default option)

Displaying Preferred Networks

Use this function to modify the display of the Preferred Networks section.

• To hide the Preferred Networks section, from the File menu select Hide Preferred 
Networks. See Figure 2.
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Figure 2: Program window — Hide Preferred Networks option selected

• To display the Preferred Networks section to the right of the list of available networks, 
from the File menu select Show at Right. See Figure 3.
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Figure 3: Program window — Show at Right option selected

Cirond pocketWiNc™ menus include options and sub-menus:

• File 

Hide Preferred Networks — hides Preferred Networks list

Show at Right — shows the Preferred Networks list to the right of the available 
networks

Show at Bottom — shows the Preferred Networks list at the bottom of the program 
window

Options — sets viewing and file saving preferences

Apply Provisioning File — (with Cirond WiNc Manager™) allows you to receive 
WEP keys automatically
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Save Available Networks — saves a file containing available networks

Exit — closes Cirond pocketWiNc™

• Tools 

View IP properties — shows IP properties for the current wireless connection

Ping — tests access to a remote device

Trace Route — determines the number of hops from the device to the selected IP 
address 

Release IP Address — releases the current IP address

Renew IP Address — renews the current IP address

Check E-mail — opens your e-mail application and checks for new messages

Web Browser — opens your web browser to the home page

• Help 

Help Topics — opens the Cirond pocketWiNc™ online Help application

About Cirond pocketWiNc™ — displays the program version, build numbers, and 
copyright date

Cirond pocketWiNc™ also includes a popup menu for working with available networks. To open 
the popup menu, tap and hold any available network. The menu includes the following items:

• Connect — connects using the selected network

• Check Internet Availability — checks whether internet access is available

• Connect & Check Internet — connects using the selected network and checks 
whether internet access is available
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• Re-obtain an IP Address — releases and renews the current IP address

• Add WEP Key & Connect — adds a WEP key to the selected network profile and 
connects

• Modify WEP key & Connect — reconfigures the WEP key for the selected network 
profile and connects

• Remove WEP Key — removes the WEP key configuration settings from the selected 
network

• Properties — opens the network properties dialog box

Cirond pocketWiNc™ also includes a popup menu for working with preferred networks. To open 
the popup menu, tap and hold anywhere in the Preferred Networks box. The menu includes the 
following items:

• Connect — connects using the selected network

• Add and Connect — adds a network to the Preferred Networks list and connects

• Edit and Connect — edits network properties and connects

• Remove — removes the network from the Preferred Networks list

• Start an Ad Hoc — starts an ad hoc network

Cirond pocketWiNc™ shortcut icons provide easy access to commonly used features.

e-mail                                                Auto-Search enabled

internet browser                                 Auto-Search disabled

WEP security key provisioning files (for more information, see Locating Provisioning 
Files and Applying WEP Keys, on page 29)
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Saving Available Network Information

Use this feature to save a file containing available network properties.

To save available networks to a file:

1. Tap the File menu and select Save Available Networks. The Save As window opens. 
See Figure 4.

Figure 4: Save As window

2. To name your available networks file, type a name in the Name field.

3. To select a folder in which to save the file, tap the Folder drop-down arrow and select 
from the available list. 

4. To select the file type, tap the Type drop-down arrow and select from the available list.
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5. To select the location of the saved file, tap the Location drop-down arrow and select 
from the available list.

6. To save the file and close the window, tap the OK button. To close the window without 
saving the file, tap the Cancel button.

Setting Network Search Frequency

Use this feature to set the frequency with which Cirond pocketWiNc™ searches for available 
networks.

To set the frequency of network searches:

1. Tap the File menu and select Options. The Option window opens. See Figure 5.

Figure 5: Options window

2. To set the search frequency, tap and drag the slider.



 Cirond pocketWiNc™ User Guide

Using Cirond pocketWiNc™ — 16 —

3. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Setting the Display of Unavailable Networks

As you move in and out of the coverage range of specific access points, Cirond pocketWiNc™ can 
be configured to either remove these entries or hold them indefinitely.

To hide unavailable networks:

1. Tap the File menu and select Options. The Option window opens. See Figure 5.

2. Select the Remove unavailable networks check box.

3. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Changing the Display of Signal Strength

Cirond pocketWiNc™ displays the signal strength of the network link in dBm units, or as a 
percentage value. 

To display the signal strength in dBm units:

1. Tap the File menu and select Options. The Option window opens. See Figure 5.

2. Select the Show signal strength in dBm check box.

3. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Important: Changes will not take effect until the next site survey search results are displayed.
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Changing the Network Properties File Format

Use this feature to save the network property information as a plain or CSV (comma separated 
value) text file. A CSV file can be imported into a spreadsheet application for record or 
presentation purposes.

To save available network information as a CSV file:

1. Tap the File menu and select Options. The Option window opens. See Figure 5.

2. Select the Save networks in CSV format check box.

3. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Administrative Tools

IP Address Management

Cirond pocketWiNc™ includes two useful administrative tools to help you maintain a mobile 
device: Release IP Address and Renew IP Address. These operations usually occur automatically, 
as required by device usage. However, they may also be employed by advanced users during 
diagnostic tests. 

• To release the current IP address, tap the Tools menu, and select Release IP Address.

• To renew the device’s IP address, tap the Tools menu, and select Renew IP Address.

Pinging an Address

Use this feature to test:

• access to a remote device
• a custom internet address
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• the default internet address
• the default gateway
• the current IP address
• the local host

To ping an address:

1. Tap the Tools menu, and select Ping. The Ping window opens. See Figure 6.

Figure 6: Ping window

2. To select the target address, select the appropriate radio button. If you select the Input 
an Address option, the field below is enabled. Enter the appropriate web address.

3. To ping the target address, tap the OK button. The Ping (IP address) window opens. 
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Figure 7: Ping (IP address) window

4. To delete the results, tap the Clear button. To ping the address again, tap the Try Again 
button. 

5. To close the window, tap the OK button.

Tracing a Route

Traceroute is a utility that records the route between your device and a specified destination 
device, calculating the number of hops and the amount of time each hop takes between the 
two devices. Information provided by this utility can be used to diagnose network problems and 
determine how direct your internet connection is. It also provides insight into how the internet 
operates.

Use this feature to trace:

• the route to a custom internet address
• the default internet address
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• the default gateway
• the current IP address
• the local host

To trace a route:

1. Tap the Tools menu, and select Trace Route. The Trace Route window opens. See 
Figure 8.

Figure 8: Trace Route window

2. To select a target address, select the appropriate radio button. If you select the Input an 
Address option, the field below is enabled. Enter the appropriate web address.

3. To trace the target address, tap the OK button. The Trace (IP Address) window opens.

4. To trace the address again, tap the Try Again button. To delete the results, tap the 
Clear button.
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5. To close the window, tap the OK button.

Usability Tools

Viewing IP Properties

Cirond pocketWiNc™ monitors TCP/IP information for the current wireless network adapter. 

To view TCP/IP information:

1. Tap the Tools menu, and select View IP properties. The View IP Properties window 
opens. See Figure 9.

Figure 9:  View IP Properties window
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The TCP/IP information includes:

adapter name
MAC address
address type
IP address
subnet mask
default gateway
DHCP server
lease date and time
lease expiry date and time
WINS servers

2. To close the window, tap the OK button.

If DHCP is enabled, you can force your computer to re-obtain an IP address. Tap the Tools 
menu, and select Renew IP address.

Using E-mail and the Web Browser

Cirond pocketWiNc™ includes two convenient shortcuts to the e-mail and web browser 
applications on your mobile device.

• To open your e-mail application, tap the Tools menu and select Check E-mail.

• To open your web browser application, tap the Tools menu and select Web Browser.

Tip: This guide uses basic networking terminology. For more information 
about these terms, refer to the appended Glossary.
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Working with Available Networks

Available Networks

The Cirond pocketWiNc™ program window displays a list of the available networks to which a 
wireless network connection can be established. This table includes the following information:

• Name — the SSID (Service Set Identifier) of the network

Icons to the left of each name indicate the network status. There are six types of network 
status icons:

access point is available

access point is unavailable

attempting to associate with this access point

associated with this access point

associated but failed to connect

associated and connected; the network connection is available

• Internet Availability — the internet access status

There are three types of internet availability status icons:

internet access is available
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internet availability is undetermined and yet to be verified

internet access is not available

• WEP — the WEP key configuration status. 

There are four WEP key configuration status icons:

WEP disabled

WEP enabled, but the key is not configured

WEP enabled and key configured

WEP enabled and keys distributed with Cirond AutoKey™

• Signal — the signal strength of the network connection

• Channel — corresponds to a specific frequency within the allowed frequency band

802.11b access points and wireless clients communicate over channels within the 2.4 GHz 
frequency band. If the wireless adapter does not report the channel properly, a question 
mark (?) is displayed.

• BSSID — (Basic Service Set Identity), a 48-bit unique identity for the corresponding 
access point
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Checking Internet Availability

This feature is used to confirm whether an internet connection is available for a specific network. 

To determine whether an internet connection is available:

1. Tap and hold any available network. A popup menu opens.

2. Select Check Internet Availability.

Once Cirond pocketWiNc™ has completed the operation, the Internet Availability icon for the 
selected network will be updated.

Connect and Check Internet Access

This feature lets you connect to an available network and immediately check internet access 
availability.

To connect to a network and determine whether an internet connection is available:

1. Tap and hold any available network. A popup menu opens.

2. Select Connect & Check Internet.

Once Cirond pocketWiNc™ has completed the operation, the Internet Availability icon for the 
selected network will be updated.

Important: Accessing a private network without authorization may violate certain laws within 
your area and is strongly discouraged by Cirond Technologies Inc.

Adding a WEP Key and Connecting to a Network

This feature lets you add security options before connecting to an available network.
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To add network security keys and connect to an available network:

1. Tap and hold any available network. A popup menu opens.

2. Select Add WEP Key & Connect. The WEP Key Configuration window opens. See 
Figure 10.

Figure 10: WEP Key Configuration window

3. To configure a WEP key, the following steps are required:

This key is delivered automatically — Select this option if WEP keys are to be 
automatically delivered by Cirond WiNc Manager™, or applied through 802.1X when 
the user configures the network. This option disables all other window elements.

Format — To select a key format, tap the drop-down arrow and select ASCII, or 
hexadecimal digits. The ASCII format allows you to use any text of the proper 
length (see Key length below) to generate the WEP key. Hexadecimal uses a 
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sequence of letters (A through F) and numbers (0 through 9) to represent the WEP 
key.

Key length — To select the WEP key length, tap the drop-down arrow and select 
64-bit (10 hexadecimal digits or 5 ASCII characters), or 128-bit (26 hexadecimal 
digits or 13 ASCII characters).

Key — Type the WEP key in the field provided. The key must be the proper length, as 
shown in Figure 10.

Key Index — To select the default key, tap the drop-down arrow and select from the 
available list. If this network uses more than one key, repeat this series of steps to fill 
in fields for any additional keys.

Use it for Network Authentication also — To use the WEP key for user 
authentication when associating with an access point, tap this check box. This setting 
must match the access point's settings.

4. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Modifying a WEP Key and Connecting to a Network

This feature lets you modify existing security options before connecting to an available network. 

To modify WEP keys and connect to an available network:

1. Tap and hold any available network. A popup menu opens.

2. Select Modify WEP key & Connect. The WEP Key Configuration window opens. See 
Figure 11.
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Figure 11: WEP Key Configuration window

3. To configure a WEP key, the following information is required:

This key is delivered automatically — Select this option if WEP keys are to be 
automatically delivered by Cirond WiNc Manager™, or applied through 802.1X when 
the user configures the network. This option disables all other window elements.

Format — To select a key format, tap the drop-down arrow and select ASCII, or 
hexadecimal digits. The ASCII format allows you to use any text of the proper 
length (see Key length below) to generate the WEP key. Hexadecimal uses a 
sequence of letters (A through F) and numbers (0 through 9) to represent the WEP 
key.

Key length — To select the WEP key length, tap the drop-down arrow and select 
64-bit (10 hexadecimal digits or 5 ASCII characters), or 128-bit (26 hexadecimal 
digits or 13 ASCII characters).
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Key — Type the WEP key in the field provided. The key must be the proper length, as 
shown in Figure 11.

Key Index — To select the default key, tap the drop-down arrow and select from the 
available list. If this network uses more than one key, repeat this series of steps to fill 
in fields for any additional keys.

Use it for Network Authentication also — To use the WEP key for user 
authentication when associating with an access point, tap this check box. This setting 
must match the access point's settings.

4. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Locating Provisioning Files and Applying WEP Keys

This feature, which works with Cirond WiNc Manager™, allows you to automatically add 
networks to your Preferred Networks list, and to automatically receive the WEP keys for these 
networks. This also allows Cirond WiNc Manager™ to rotate the WEP keys in use and to have 
these keys sent to you, without any effort on your part. The provisioning process actually 
establishes an encrypted link between Cirond pocketWiNc™ and Cirond WiNc Manager™ so that 
Cirond WiNc Manager™ can identify you and will allow you onto the managed WLAN network. 

To apply a provisioning file:

1. Tap the WEP Security Key Provisioning Files icon at the bottom of the screen, or tap 
the File menu, and select Apply Provisioning File. The Select the Provisioning File 
dialog box opens.

2. Browse to locate the appropriate provisioning file (supplied by your network 
administrator). 

Tip: If you are not using Cirond WiNc Manager™, WEP keys are provided 
by a network administrator or configured in the access point’s 
settings to secure the network connection.
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3. To open the selected file, tap the file name. 

Viewing Network Connection Properties

This feature lets you monitor your available network properties.

To view the properties of any available network connection:

1. Tap and hold the network. A popup menu opens.

2. Select View Properties. The Network Connection Properties window opens.

Figure 12: Network Connection Properties window
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The network connection properties information includes:

Name (SSID)
status
internet access availability
signal (db)
network type
WEP status
WEP key status
channel number
BSSID (MAC address)

3. To close the window, tap the OK button.

Working with Preferred Networks

Preferred Networks

The Cirond pocketWiNc™ program window displays a list of saved user network profiles. User 
network profiles provide automatic WEP key support and Wi-Fi® connectivity based on a user-
defined priority sequence.

Adding a Network to the Preferred Networks List

You can quickly add known networks to your Preferred Networks list, even if the networks are 
configured to hide their SSID from site survey. This allows you to connect to your favorite 
networks easily, without having to reconfigure WEP and connection settings each time. 

Tip: This guide uses basic networking terminology. For more information 
about these terms, refer to the appended Glossary.
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Important: If the Preferred Networks list is not displayed, refer to Displaying Preferred 
Networks on page 9.

To add a network to the Preferred Networks list:

1. Tap and hold any preferred network. A popup menu opens. 

2. Select Add and Connect. The Add and Connect window opens. See Figure 13.

Figure 13: Add and Connect window

3. Type the Network Name (SSID) in the field provided.

4. If the network is WEP enabled, select the Enable WEP check box. The Modify WEP Key 
button becomes available.
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5. Tap the Modify WEP Key button and follow Step 3 of Adding a WEP Key and Connecting 
to a Network on page 25.

6. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Creating Ad Hoc Networks

You can also create ad hoc networks and add them to your Preferred Networks list. Cirond 
pocketWiNc™ will first search the local vicinity for active ad hoc networks. If none exist, Cirond 
pocketWiNc™ will host a new ad hoc network that other parties can join.

Important: If the Preferred Networks list is not displayed, refer to Displaying Preferred 
Networks on page 9.

To create an ad hoc network and add it to the Preferred Networks list:

1. Tap any preferred network. A popup menu opens.

2. Select Start an Ad Hoc. The Start an Ad Hoc Network window opens. See Figure 14.
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Figure 14: Start an Ad Hoc Network window

3. Select the This is an Ad Hoc Network check box.

4. To set the channel, tap the Channel Number drop-down arrow and select from the 
available list.

Important: If you are hosting the ad hoc network, you must choose which channel you wish 
to use. Any channel can be used, although it is recommended to stay at least two 
channels removed from any other network in your immediate vicinity. Use the 
available networks display to determine which channels are already in use.

When starting an ad hoc network with the Orinoco wireless adapter, the channel 
number is assigned by the Orinoco driver and cannot be changed by the user.
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5. Type the network name in the Network Name (SSID) field.

6. If the network is WEP enabled, select the Enable WEP check box. The Modify WEP 
Key button becomes available.

7. Tap the Modify WEP Key button and follow Step 3 of Adding a WEP Key and Connecting 
to a Network.

8. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.

Modifying WEP Security Keys for Preferred Networks

Users may also be required to update the security properties of preferred networks.

Important: If the Preferred Networks list is not displayed, refer to Displaying Preferred 
Networks on page 9.

To modify security settings for a preferred network:

1. Tap and hold any preferred network you wish to modify. A popup menu opens.

2. Select Edit and Connect. The Edit and Connect window opens. See Figure 15.

Tip: If you are adding an existing and secured ad hoc network to the 
Preferred Networks list, obtain the WEP keys from the network 
administrator or the person that created the network.
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Figure 15: Edit and Connect window

3. Tap the Modify WEP Key button and follow Step 3 of Adding a WEP Key and Connecting 
to a Network on page 25.

4. To save changes and close the window, tap the OK button. To close the window without 
saving changes, tap the Cancel button.
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Troubleshooting

In this section:

• answers to frequently asked questions

• error messages and recommendations

Frequently Asked Questions (FAQ)

Important: For the latest FAQ on Cirond pocketWiNc™ and other Cirond products, refer to the 
Customer Service page at www.cirond.com.

• What platforms does Cirond pocketWiNc™ support? 

Microsoft® Pocket PC 2002, Windows® CE 3.0, Windows® CE .NET

• Which CompactFlash® cards does Cirond pocketWiNc™ support? 

Cirond pocketWiNc™ supports most popular CompactFlash® cards. 

As of March 2003, Cirond pocketWiNc™ supports the following cards:

Card Support

AmbiCom CF Card WL1100C #*

Belkin FSD6060 #
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Important: For a current list of supported hardware, refer to the Customer Service page at 
www.cirond.com. 

Cirond pocketWiNc™ Messages

Cirond pocketWiNc™ messages display application performance information. The following is a 
list of possible error messages and user recommendations:

Dell TrueMobile 1180 Y

D-Link DCF-650W Y*

D-Link DCF-660W Y*

Hawking CF100W Y

Linksys WCF11 Y*

Linksys WCF12 Y

NETGEAR MA701 *

SMC 2642W Y*

Z-Com XI-800 Y*

Toshiba e740 (built in Wi-Fi® capability) Y

Compaq iPAQ 5450 (built in Wi-Fi® capability) #*

Card Support

Tip: Y Indicates Cirond has tested this combination, and found it functional.
* Indicates that this card requires an updated driver to be functional.
# Indicates the card has been tested by others, and found to work.
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• Unable to locate adapter.

If Cirond pocketWiNc™ fails to detect a supported wireless adapter, the unable to locate 
Adapter error message is displayed. See Figure 16.

Figure 16: Unable to locate adapter

Tap the OK button to close the message. Ensure a wireless adapter is installed.

• The current adapter has been removed.

If the wireless adapter is removed during program operation, the application displays an 
error message and will shut down. See Figure 17.

Figure 17: The current adapter has been removed

Tap the OK button to close the message. Install the wireless adaptor and re-start the 
application.

• The character in field <Key:> in position 'n' is invalid.

If your WEP key contains an invalid character, Cirond pocketWiNc™ reports its position. 
For example, the hexadecimal format permits only the letters A through F and the 
numbers 0 through 9. See Figure 18.
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Figure 18: The character in field <Key:> in position 3 is invalid

Tap the OK button to close the message. Change the character or change the key format 
to suit the character. For more information on WEP key formats, see Adding a WEP Key 
and Connecting to a Network.

• The length of the field <Key> is too long.

Cirond pocketWiNc™ will not allow WEP keys that exceed the proper length. For example, 
64-bit hexadecimal keys must be exactly 10 characters. See Figure 19.

Figure 19: The length of the field <Key> is too long

Tap the OK button to close this message. Enter a password that contains the required 
number of characters.

• The length of field <Key:> is too short.

Cirond pocketWiNc™ will not allow WEP keys that are less than the proper length. For 
instance, 64-bit hexadecimal keys must be exactly 10 characters. See Figure 20.
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Figure 20: The length of field <Key:> is too short

Tap the OK button to close this message. Enter a password that contains the required 
number of characters.

• IP address is invalid.

Cirond pocketWiNc™ will report if an IP address is invalid. See Figure 21.

Figure 21: IP address is invalid

Tap the OK button to close this message. Confirm the IP address (note that the target 
server may be experiencing a temporary outage). If the IP address is correct and the 
problem persists, see Adding a WEP Key and Connecting to a Network for detailed 
instructions on WEP key settings.

• File Name is Invalid.

Cirond pocketWiNc™ will report file names that are not supported by your operating 
system. See Figure 22.



 Cirond pocketWiNc™ User Guide

Troubleshooting — 42 —

Figure 22: File name is invalid

Tap the OK button to close this message. Review the file naming parameters of your 
operating system. 

• This network is already in the list.

Cirond pocketWiNc™ will notify you before saving over a network that is already included 
in your Preferred Networks list. See Figure 23.

Figure 23: This network is already in the list

To replace the network and close the message, tap the Yes button. To close the window 
without saving the network, tap the No button.

• Network name (SSID) is longer than 32 characters.

The 802.11 specification does not allow network names (SSIDs) that exceed 
32 characters. See Figure 24.
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Figure 24: Network name (SSID) is longer than 32 characters

Tap the OK button to close this message. Enter a network name (SSID) with a maximum 
length of 32 characters.

• Please specify a network name (SSID).

Cirond pocketWiNc™ requires that a network name (SSID) be specified. See Figure 25.

Figure 25: Please specify a network name (SSID)

Tap the OK button to close this message. Enter a network name (SSID) with a maximum 
length of 32 characters.
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• Windows® is doing DHCP operations.

Cirond pocketWiNc™ prioritizes DHCP operations over all other program functions. See 
Figure 26.

Figure 26: Windows® is Doing DHCP Operations

Tap the OK button to close this message. Wait for Cirond pocketWiNc™ to complete 
DHCP operations before continuing.
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Glossary

Standard terms and acronyms used in this guide:

802.11a — a subset of the IEEE technical standards covering WLAN technology. 802.11a-based 
equipment is commercially available, provides data rates up to 54Mbps, and operates in the 
5GHz ISM band. IEEE 802.11 networks are comprised of stations, wireless medium, access 
points, and a distribution system.

802.11b — currently the most common subset of the IEEE technical standards covering WLAN 
technology. 802.11b-based equipment provides wireless communication at up to 11Mbps and 
operates within the 2.4GHz ISM band. IEEE 802.11 networks are comprised of stations, wireless 
medium, access points, and a distribution system.

802.11g — a subset of the IEEE technical standards covering WLAN technology for higher rate 
(20+ Mbps) extensions in the 2.4GHz ISM band.

access point — a device found within an IEEE 802.11 network that provides the point of 
interconnection between the wireless station (laptop computer, PDA etc.) and the wired network.

ad hoc network — an IEEE 802.11 network operating in IBSS mode in which two or more 
wireless stations communicate at a peer-to-peer level without the need of an access point. As 
such, wireless stations communicate with each other across a temporary network.

ASCII — (American Standard Code for Information Interchange), the predominant character set 
encoding of present-day computers, ASCII provides a means of exchanging text among 
dissimilar computers and computer programs.

association — an IEEE 802.11 network term that identifies the first step in establishing a 
connection between an access point and a client station. An association is required before any 
information can be passed between the station and other nodes via the access point.
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BSS — (Basic Service Set), a term used to describe the collection of stations which may 
communicate together within an 802.11 WLAN. The BSS may or may not include an access point 
that provides a connection onto a fixed distribution system such as an Ethernet network. Two 
types of BSS exist; Independent Basic Service Set and Infrastructure Basic Service Set.

BSSID — (Basic Service Set Identifier), a 48-bit identity for a particular BSS within an area. In 
Infrastructure BSS networks, the BSSID is the MAC address of the access point, and in 
Independent BSS or ad hoc networks, the BSSID is generated dynamically.

channel — a specific frequency within a given frequency band. Access points and wireless 
clients communicate over channels within the 2.4 GHz frequency band, e.g., Channel 2 runs 
specifically at 2.417 GHz. Channel 3 runs at 2.422 GHz. Users should note that standard 802.11b 
communications are actually spread across one channel above and one channel below the 
selected channel. Therefore, the use of consecutive channels is not recommended.

connect  — complete all aspects of connecting to a given network beyond simply associating 
with an access point. Typically, this includes obtaining an IP address on the given network and 
the ability to generate traffic on that network.

CSV — (Comma Separated Value), a common file format used for exchanging data between 
spreadsheet and database applications.

dBm — abbreviation for decibel(s) referenced to one milliwatt. dBm is used in communication 
work as a measure of absolute power values. Zero dBm equals one milliwatt.

DHCP — (Dynamic Host Configuration Protocol), a TCP/IP protocol that enables a personal 
computer or workstation to obtain temporary or permanent IP addresses from a centrally-
administered server. DHCP provides a mechanism for allocating IP addresses automatically and 
dynamically, allowing IP addresses to be reused. 

DNS — (Domain Name Service), a networking function that is used to lookup another 
computer’s actual IP address from an easier-to-remember name. For example, IP address 
66.37.27.165 belongs to www.cirond.com.

domain — a group of servers and workstations, or subnetwork, governed by a single security 
database.
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encryption — the security mechanism used for the transformation of data from an intelligible 
form (plaintext) into an unintelligible form (ciphertext), to provide confidentiality. The inverse 
process is called decryption.

encryption key — a secret password or code string used as part of the encryption process.

ESS — (Extended Service Set), a service set comprised of a number of IEEE 802.11 BSSs and 
enables limited mobility within the WLAN. Stations are able to move between BSSs within a 
single ESS, yet still remain “connected” to the fixed network. As a station moves into a new BSS, 
it carries out a re-association procedure with the new access point. All BSSs within the ESS will 
use the same SSID.

ESSID — (Extended Service Set Identifier), another form of SSID, a 32 character (or less) name 
for a wireless network. 

gateway — the device on a network responsible for relaying internet traffic to and from the 
network.

hexadecimal — a base-16 number system: contains 16 sequential numbers as base units 
(including 0) before adding a new position for the next number. The numbers 0 through 9 and 
letters A through F represent the numbers 0 through 15.

hop — the trip a data packet takes from one router or intermediate point to another in a 
network.

host —  any computer on a network using the Internet Protocol (IP).

IBSS — (Independent Basic Service Set), also known as an ad hoc network, this is the simplest 
of all IEEE 802.11 networks in that no network infrastructure is required. An IBSS is comprised of 
one or more stations which communicate directly with each other. Note: The abbreviation should 
not be confused with an Infrastructure BSS.

IEEE — Institute of Electrical and Electronic Engineers

infrastructure BSS — (infrastructure Basic Service Set), a type of IEEE 802.11 network 
comprised of both stations and an access point that are used for all communication within the 
BSS, even if the stations reside within the same vicinity. A station sends information to the access 
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point, which in turn forwards it to the destination station. If the information is destined for a 
wired node, the access point forwards it to the fixed network.

IP — (Internet Protocol), provides a connectionless service between networks. The protocol 
provides features for addressing, type-of-service specification, fragmentation and reassembly, 
and security. It is a Layer 3 protocol in the TCP/IP protocol stack.

IP address — a 32-bit address that is assigned to hosts. An address belongs to one of five 
classes (A, B, C, D, or E) and is written as 4 octets separated by periods, ranging from 0.0.0.0 
through to 255.255.255.255. Each address consists of a network number, an optional 
subnetwork number, and a host number. The network and subnetwork numbers are used for 
routing. The host number is used to address an individual host within the network or 
subnetwork.

ISM band — (Industrial, Scientific, and Medical band), radio frequency bands that the FCC 
authorized for WLANs (902MHz, 2.400GHz, and 5.7GHz).

LAN — (Local Area Network), a network shared by communicating devices, usually on a small 
geographical area.

MAC address — (Medium Access Control), often referred to as a hardware address, this 
identifies a device within a defined network area such as a LAN. A common example of a MAC 
address would be an Ethernet address that is associated with an Ethernet NIC used on all 
computers connected on an Ethernet LAN.

Mbps — megabits per second 

MBps — megabytes per second

NIC — (Network Interface Card) hardware that allows a device to communicate across a 
network, typically a card that inserts into the device, which stores a MAC address for that device.

Ping — (Packet Internet Groper), a utility program that tests access to a device by sending a 
series of messages and measuring the replies.

provisioning — a Cirond Technologies proprietary security measure for Cirond WiNc 
Manager™ controlled networks. Provisioning establishes a link between Cirond WiNc Manager™ 
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and a specific client, allowing the client to receive a list of profiles for a specific network and to 
receive distributed WEP keys.

provisioning file — a file that contains and supplies the encrypted provisioning information.

signal quality — a composite measure of the signal strength and the amount of noise 
(conflicting signals) that occur. 

signal strength — the strength of a radio signal, which decreases as the user moves further 
away from the signal source, and/or as there are more obstructions between the user and the 
signal source.

site survey — a process by which Cirond pocketWiNc™ searches the immediate vicinity for 
access points, typically user-initiated.

SSID — (Service Set Identifier), a 32 character (or less) name for a wireless network.

subnet mask — a local bit mask (set of flags) that specifies which bits of the IP address specify 
a particular IP network or a host within a subnetwork. An IP address of 128.66.12.1 with a 
subnet mask of 255.255.255.0 specifies host 1 on subnet 128.66.12.0. The subnet mask 
determines the maximum number of hosts on a subnetwork.

Traceroute  — a utility that records the route (the specific routing computers at each hop) 
through the internet between a computer and a specified destination computer. 

TCP/IP — (Transmission Control Protocol/Internet Protocol), the TCP/IP Suite includes, but is 
not limited to, protocols such as TCP (Transmission Control Protocol), IP (Internet Protocol), UDP 
(User Datagram Protocol), ICMP (Internet Control Message Protocol), FTP (File Transfer Protocol, 
and SMTP (Simple Mail Transfer Protocol).

USB — (Universal Serial Bus), provides an expandable, plug and play serial interface that 
ensures a standardized, low-cost connection for peripheral devices such as keyboards, mice, 
joysticks, printers, scanners, storage devices, modems, and video conferencing cameras.

WEP — (Wired Equivalent Privacy), a confidentiality and integrity provision incorporated in the 
IEEE 802.11 WLAN. WEP uses the RC4 stream cipher to protect data. There are two levels of 
WEP commonly available; one based on a 40-bit encryption key and 24-bit initialization vector 
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(64-bit encryption), and one based on a 104-bit encryption key and 24-bit initialization vector 
(128-bit encryption). 

WEP key — part of the provisioning file, a WEP key is an encryption key used when configuring 
a wireless connection. An access point uses up to four WEP keys. Different stations require the 
same set of keys to communicate. Each station and access point must be configured to use one 
of the available four keys for transmitting. Thus all stations should be configured to use the same 
set of four keys in order to be able to decrypt traffic received from other stations.

Wi-Fi® — (Wireless Fidelity), an interoperability standard developed by the Wireless Ethernet 
Compatibility Alliance and issued to those manufacturers whose IEEE 802.11a and 802.11b 
equipment has passed a suite of basic interoperability tests. Equipment passing these tests 
carries the Wi-Fi® logo.

wireless adapter — a hardware device which allows the wireless station (laptop computer, PDA 
etc.) to communicate over an IEEE 802.11 network with a remote machine.

WINS — (Windows Internet Naming Service), a proprietary Microsoft® application that maps 
easily remembered Windows machine names to the corresponding IP addresses.

WLAN — (Wireless Local Area Network), a generic term covering a multitude of technologies 
that provide local area networking via a radio link. Examples of WLAN technologies include 
Wi-Fi®, IEEE 802.11b and 802.11a, HiperLAN, Bluetooth, Infrared Data Association, and Digital 
Enhanced Cordless Telecommunications.

WiNc Manager™ — a Wi-Fi® network management product that simplifies and fortifies the 
management of 802.11 networks. Cirond WiNc Manager™ operates in conjunction with Cirond 
WiNc™ for Windows® and pocketWiNc™ for Microsoft® Pocket PC 2002 and Windows® 
CE .NET, and is compatible with the 80211.a, 802.11b, and 80211.g standards. For more 
information on Cirond products, visit www.cirond.com.


